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Introduction

Welcome to Mastercam’s Tool Manager Getting Started Guide. This guide provides 
information about Mastercam’s new stand-alone Tool Manager. Some of the informa-
tion is in a step-by-step format, and some of the information is paragraph format. 
Both formats walk you through how and when to use the stand-alone Tool Manager.

Tutorial Goals
 Become familiar with Mastercam’s stand-alone Tool Manager
 Learn how to customize the Tool Manager workspace
 Work with tool libraries (.TOOLDB) and their components
 Create and edit tools and holders in Mastercam’s classic Tool Manager

Estimated time to complete this tutorial: 3 hours

General Tutorial Requirements
All Mastercam tutorials have the following general requirements:

 You must be comfortable using the Windows® operating system.
 Each lesson in the tutorial builds on the mastery of preceding lesson’s skills. 

We recommend that you complete them in order. 
 Additional files may accompany a tutorial. Unless the tutorial provides specific 

instructions on where to place these files, store them in a folder that can be 
accessed from the Mastercam workstation, either with the tutorial or in any 
location that you prefer.

 You will need an internet connection to view videos that are referenced in the 
tutorials. All videos can be found on our YouTube channel: 
www.youtube.com/user/MastercamTechDocs.
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LESSON 1
1Mastercam’s Tool Manager

In this lesson, you learn about the stand-alone Tool Manager interface, how it 
compares to the classic Mill/Router and Lathe Tool Managers in Mastercam, and the 
recommended general workflow.

Lesson Goals
 Become familiar with the stand-alone Tool Manager
 Learn how the stand-alone Tool Manager differs from Mastercam’s Classic 

Mill and Lathe Tool Managers
 Understand when and why to use it
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Exercise 1: Tool Manager Overview
Mastercam's Tool Manager provides an efficient and comprehensive way to manage 
tools and tool holding components, and to create tool assemblies to use in 
Mastercam. Besides the tooling component support, Tool Manager also integrates 
work material and cut parameter data so that you can accommodate a manufacturer's 
cutting recommendations. You can also create your own cut parameter data and store 
it in the database.
Launch the stand-alone Tool Manager separately from Mastercam by choosing Tool 
Manager from your Start menu's Mastercam folder. Certain Tool Manager functions 
are integrated into the Mastercam interface and are launched from within Mastercam 
when you create new tools, holders, and assemblies. While you are in Tool Manager, 
your data is automatically saved as you work, avoiding possible work loss and elimi-
nating the need for manual backups.
Tool Manager's database format (TOOLDB) is faster and more reliable than older data-
base formats. Its non-proprietary format is easily accessed by third-party contributors, 
such as tooling manufacturers, who want to keep you up to date with the most recent 
tooling and tooling components. Although you can only open the TOOLDB database 
format in Tool Manager, in Mastercam, you can still open both the TOOLDB and 
TOOLS-x database formats. However, the Save As function only saves the database out 
in the TOOLDB format.
TOOL MANAGER GETTING STARTED GUIDE
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Tool Manager Interface
This section contains brief descriptions of the stand-alone Tool Manager interface. 
These interface objects are covered in detail in the step-by-step procedure lessons of 
this Getting Started Guide.

1. Tabs - Tabs function somewhat like dialog boxes but look similar to toolbars. You 
cannot undock or dock a tab, nor are they customizable.

2. Database Explorer - Use the Tool Manager Database Explorer to access content in 
tool database files (TOOLDB). Right-click an item to expand or collapse it. To work 
with items in the database tree view (i.e., Cutting Tools, Tool Assemblies, Holders, 
Materials, and Cut Parameters), double-click the item.

3. Assembly Tree - Use the Assembly Tree to open, create, and edit assemblies in the 
open TOOLDB database. Tool Assemblies may contain one tool and one or more 
holder components. Use the Assembly Tree to navigate the individual assembly 
items. If you select (double-click) Tool Assemblies in the Database Explorer or 
choose the Assembly button in the Home tab, the Assembly Tree appears below 
the Database Explorer and the Assemblies document appears in the documents 
area.
TOOL MANAGER GETTING STARTED GUIDE
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4. Document Datagrids - Tool Manager uses "documents" to organize data such as 
tools, holders, and assemblies. The main workspace uses a tab-style interface to 
present these documents.

5. Graphics Window - The graphics window is part of a document, and displays what 
you have selected in the document datagrid. For example, if you are working in 
the Assembly document, the graphics window displays the assembly you have 
selected in the datagrid.

6. Properties Grid - Tool Manager Properties Grid displays properties for cutting 
tools, assemblies, holders, extensions, materials, and cutting parameters. The 
properties displayed in the Properties Grid depend on which document type you 
have open and which item you have selected in the document.

Exercise 2: Stand-Alone vs. Classic Tool Managers
Although this document focuses on the stand-alone Tool Manager, Mastercam offers 
more than one Tool Manager to create, edit, and manage your tools, tooling compo-
nents, and tool libraries. Each Tool Manager is accessed with different workflows and 
circumstances. 
TOOL MANAGER GETTING STARTED GUIDE
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Stand-alone Tool Manager

The stand-alone Tool Manager provides an interface to manage Mill and Router tools 
and tool holding components, and to create tool assemblies to use in Mastercam. In 
addition to the tooling component support, Tool Manager also integrates work mate-
rial and cut parameter data so that you can accommodate a manufacturer’s cutting 
recommendations. You can also create your own cut parameter data and store it in the 
database. 
To work in the stand-alone Tool Manager, select the Windows’ Start menu, and 
choose Mastercam, Tool Manager. Once you access the stand-alone Tool Manager, 
click the Help button for more details. You do not have to have Mastercam open to 
access and use the stand-alone Tool Manager. 
TOOL MANAGER GETTING STARTED GUIDE
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Classic Mill/Router Tool Manager

The classic Mill/Router Tool Manager allows you to view and manage tool libraries, the 
tools in your part file, and tool definitions. Use it to:

 View tools stored in a tool library, machine group, or both.
 Create new tools and store them in a tool library or machine group.
 Copy tools to/from a library to a machine group, or between different libraries 

or machine groups.
Many functions of the classic Mill/Router Tool Manager interface use the integrated 
stand-alone Tool Manager functions such as the editing and creating wizards for tools 
and holders. Access the classic Tool Manager by selecting Tool Manager from the Mill 
or Router Toolpaths tab. (This option is not available in Design.)
TOOL MANAGER GETTING STARTED GUIDE
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Classic Lathe Tool Manager

The classic Lathe Tool Manager has the same features as the classic Mill/Router Tool 
Manager.

NOTE:  To access the classic Lathe Tool Manager, you must have a 
Lathe machine definition loaded and have the insertion arrow in that 
machine group.

Access the Lathe Tool Manager by right-clicking in the Toolpath parameters tab of a 
lathe operation’s dialog box, or selecting Lathe Tool Manager from the Toolpaths, 
Turning tab in the ribbon bar. (This option is not available in Design.)
TOOL MANAGER GETTING STARTED GUIDE
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Exercise 3: Reasons to Use the Stand-Alone Tool Manager
There are many reasons to use the stand-alone Tool Manager instead of the classic 
Tool Manager. Here are some of the main reasons:

 Work in Tool Manager without Mastercam open - Although you need to have 
Mastercam installed to run the stand-alone Tool Manager, you do not have to 
have Mastercam open. You don’t even need to have a SIM plugged in. When 
you create, edit, and organize your tool libraries without running Mastercam, 
you increase your computer’s performance while reserving that licensed 
Mastercam seat for someone else.

 Search for library components using Search window - Mastercam’s stand-
alone Tool Manager offers a Search window that shows you results that match 
your search criteria. You can save searches for future use as favorites, and you 
can view recent searches. See Searching for a Library Component (page 31) 
for details.

 Copy tool library components between libraries - You can have multiple 
instances of the stand-alone Tool Manager open. To copy tools, holders, and 
assemblies from one TOOLDB to another, open the different tool libraries in 
separate instances of Tool Manager and drag and drop the tooling 
component from one Tool Manager to the other. See Copying Components 
Between Tool Libraries (page 53) for details.

 Create and edit assemblies - Mastercam’s stand-alone Tool Manager 
provides several ways to create and edit tooling assemblies. You can drag and 
drop assembly components into the Assembly Tree, you can work directly in 
the Tool Manager’s graphics window to edit assemblies, and you can change 
the parameters for an assembly or for each of the assembly components in 
the Properties Grid. See Working with Components in a Tool Library (page 
35) for details.

 Customizable workspace - The workspace of the stand-alone Tool Manager 
allows you to undock the major interface objects. This is useful if you work 
with multiple monitors. It is also useful if you just want to reposition or hide 
the interface windows to suit your preferences. See Customizing the Tool 
Manager Workspace (page 17) for details.

 Create and edit materials and cut parameters - Tool Manager allows you to 
create and edit materials and cut parameters. These settings are stored in the 
tool library and are easily accessed through Mastercam when you create or 
edit a tool with the Tool Wizard.
TOOL MANAGER GETTING STARTED GUIDE
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 Multi-Editing - The stand-alone Tool Manager allows you to select multiple 
document items, such as multiple tools, and edit the properties for all 
selected items with the Properties Grid.

Exercise 4: Recommended Workflow
The stand-alone Tool Manager is designed to create tool libraries (TOOLDB) that can 
be specific to a job and/or machine. These tool libraries can be used as part of a job 
“kit” that reside on one machine, or travel with the part.
The recommended workflow is to set up your tool libraries using the stand-alone Tool 
Manager, and then use those libraries in Mastercam to apply to specific jobs, parts, 
and machines.
TOOL MANAGER GETTING STARTED GUIDE
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LESSON 2
2Customizing the Tool Manager 
Workspace

In this lesson, you learn how to customize, save, and reset your workspace.

Lesson Goals
 Undock, move, and hide Tool Manager panes
 Use the window functions in the ribbon to customize your workspace
 Move, display, sort, and view document datagrids and the graphics window

Exercise 1: Docking, Hiding, and Repositioning Tool Manager Panes
Panes in Tool Manager, such as the Database Explorer, Assembly Tree, and Properties 
Grid, can all be undocked, repositioned, re-docked, and hidden. For this exercise, you 
will use the Properties Grid for a tool as an example of how to perform these tasks.
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1 Open Tool Manager from your 
Mastercam folder in the Windows’ 
Start menu.

IMPORTANT: After installing Mastercam, you must open Mastercam 
before opening the stand-alone Tool Manager for the first time. Opening 
Mastercam builds Tool Manager support files. After opening Mastercam, 
you can close it and successfully open the stand-alone Tool Manager. 
You don’t have to have Mastercam running to use the stand-alone Tool 
Manager. If you are working from a new Mastercam install and try to 
open the stand-alone Tool Manager without at least opening and closing 
Mastercam, you will receive an error message prompting you to open 
Mastercam.

2 Click the Open button and navigate 
to the install location of this guide.

3 Select gsg_Tool_Manager.tooldb and click Open to load the database.
TOOL MANAGER GETTING STARTED GUIDE
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4 Double-click Cutting Tools in the 
Database Explorer to open the 
Tools document, and choose any 
tool to populate the Properties grid.

5 Click the Properties grid title bar, 
and drag and drop it to a position 
outside of the Tool Manager. 

TIPS: 

 If you use multiple monitors, you 
can dock the panes on another 
monitor, providing more work-
space in Tool Manager.

 You can also use the Float func-
tion in the Options drop-down 
list.

 The Dock as Document option is 
unavailable when working in the 
Properties grid.

6 To re-dock the Properties Grid to 
the default position in Tool 
Manager, click the drop-down 
Options button and choose Dock. 
You can also double-click the title 
bar to re-dock the grid.
TOOL MANAGER GETTING STARTED GUIDE
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7 To hide the Properties Grid in Tool 
Manager, click the drop-down 
Options button and choose Auto 
Hide. 

NOTE: When you hide a pane, Tool 
Manager docks it as a tab. Click the 
tab to open the Properties grid, and 
then click the drop-down Options 
button and choose Dock to re-dock it 
to its default state.

8 After closing the Properties Grid, or any other Tool Manager pane, re-open it 
by clicking its button in the Show group of the View tab.

Exercise 2: Using the Functions on the View tab
In this exercise, you learn to use the functions in the View tab.

1 If you closed Tool Manager, open it and load the gsg_Tool_Manager.tooldb 
database.

2 Click the View tab to access workspace viewing options.

TIP: Hover your mouse over any of the buttons to view tooltips.
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3 Use the Window buttons to change the arrangement of your workspace.

4 Use the Show buttons to display the different Tool Manager panes and grids.

5 Use the 3D View buttons to fit and change the view of the tool, holder, or 
assembly in the graphics window.

NOTE: The 3D View options are only available when you have a tool, 
holder, or assembly document open.

Exercise 3: Displaying, Sorting, and Customizing Documents
In this exercise, you learn to display, sort, and customize documents. You will also 
learn how to split (tile) documents, which includes customizing the graphics window’s 
display.
TOOL MANAGER GETTING STARTED GUIDE
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Customizing the Document Display
1 You should still have the Tools document open. If not, double-click Cutting 

Tools in the Database Explorer to open the Tools document, and choose any 
tool to populate the Properties grid.

2 Open the other document types (Assemblies, Holders, Materials, and Cut 
Parameters) using the same double-clicking action.

3 To sort a document by columns, click a column heading to sort the data by 
either ascending or descending order. Click the heading again to reverse the 
order. Click a third time in the same column header to restore the original sort 
order. This example shows sorting by tool number. However, you can sort by 
any column such as Name, Diameter, Cutting Depth, etc.

4 To customize the documents and graphics window layout, use the buttons in 
the splitter control located in the display separator between the datagrid and 
graphics window.
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NOTES:

 Moves the document and graphics window above or below each 
other.

 Splits the document and graphics window vertically (side-by-side).

 Splits the document and graphics window horizontally (over/under).

 Removes the splitter and maximizes the view that is displayed on 
the top or left side (depending on the orientation of the split).

 The double lines in the splitter control indicate 
that you can reposition the splitter by dragging it with your 
mouse.

Grouping Document Data
1 To view a datagrid by column groups, drag and drop the column header into 

the area just below the document tabs (as shown below).

TIP:  Use the plus and minus symbols to expand and collapse grouped 
results.
TOOL MANAGER GETTING STARTED GUIDE
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2 Click the button with the column name to toggle between ascending and 
descending the sort order. Clicking the button a third time removes sorting 
and restores the list to its default database order.

3 To ungroup your datagrid results, drag and drop the button with the column 
name back into the datagrid's column heading area.

Splitting (Tiling) Documents
Use the View tiling options (as shown below) to split the document workspace to view 
Documents concurrently.
TOOL MANAGER GETTING STARTED GUIDE
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1 To tile documents horizontally, open the documents and click the Tile 
Horizontal button.
TOOL MANAGER GETTING STARTED GUIDE
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2 To tile documents vertically, open the documents and click the Tile Vertical 
button.

NOTES: 

 To save your customized workspace, click the Save Workspace button 
in the View tab.

  You can have multiple saved workspaces. To load a workspace, 
click the Load Workspace button, also in the View tab.

3 Click Reset Workspace and close Tool Manager. Your workspace resets to its 
default layout when you restart Tool Manager.
TOOL MANAGER GETTING STARTED GUIDE
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3Working with Tool Library Files 
(.TOOLDB)

In this lesson, you learn how to work with tool libraries.

Lesson Goals
 Switch to metric database output
 Create and edit tool libraries
 Use the stand-alone Tool Manager's Search feature

Exercise 1: Creating Tool Libraries
In this exercise, you learn to create tool libraries by either copying an existing library or 
creating a TOOLDB from scratch. Because you create metric tools and holders later in 
this guide, you set the default units to metric in this exercise. 

NOTES:

 The default unit setting is read from Mastercam’s System Configuration. 
For more information see the Start/Exit property page (System 
Configuration) help topic in Mastercam.
 Tool Manager remains in the metric state until you manually change it 

back to inch, even if you use multiple sessions of Tool Manager or turn 
off your computer.
 All library (database) components are created with metric values as long 

as the default unit value is set to metric. For example, all new tools and 
holders created in the stand-alone Tool Manager or from within 
Mastercam, are created using metric values until this option is changed 
back to inch units.
 You can have both inch and metric tooling components in the 

same library (.TOOLDB file).
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Creating a Tool Library from an Existing Library
1 If the stand-alone Tool Manager is not already running, Open Tool Manager 

from your Mastercam folder in the Windows’ Start menu. 
2 From the stand-alone Tool Manager, open gsg_Tool_Manager.tooldb.
3 After the tool library loads, click the 

File tab (backstage view) and choose 
Options.

TIP: The Tool Manager default unit measurements are based on your 
Mastercam configuration. If you have Mastercam already set to metric 
for the unit defaults, you can skip to step 6 of this procedure.

4 In the Application Options dialog 
box, choose the General page.

5 If it’s not already selected, click the 
Metric option under Units.

6 Click OK.
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7 In the File tab, choose Save As.
8 Save the TOOLDB as 

gsg_Tool_Manager_Tut.tooldb.

NOTE: You save the library with a 
different file name so that you don’t 
overwrite the file provided with this 
guide.

Creating a New Tool Library from Scratch
1 In the File tab (backstage view), click 

New, and then click the Tool 
Database button.
This opens a second instance of Tool 
Manager.

2 In the Save As dialog box, enter a 
new file name of your choice and 
click Save.

NOTE: You can create and add 
library components to the new data-
base as detailed in Working with 
Components in a Tool Library (page 
35). As you work in Tool Manager, 
your changes are automatically 
saved to the database.

3 Close both sessions of Tool Manager, choosing to save any changes if 
prompted. By closing both sessions, you ensure that all your changes are 
saved.

Exercise 2: Opening and Editing a Tool Library
In this exercise, you open an existing library in Tool Manager and edit one or more of 
its components. 

1 Open Tool Manager from your Windows’ Start menu.
TOOL MANAGER GETTING STARTED GUIDE
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2 Click Open and navigate to the 
gsg_Tool_Manager_Tut.tooldb file 
you created in the previous exercise. 

IMPORTANT:  Do not open the gsg_Tool_Manager.tooldb file installed 
with this guide. We recommend that you leave that file unchanged in 
case you need to start over.

3 Open each of the document types 
by double-clicking its library 
component in the Database 
Explorer. 

TIP: As with any document type, you can close the Start page by 
clicking the X in its tab. Closing the Start page is optional.

4 Review the buttons in the New Component, New Milling, and New Hole 
Making groups. Hover your mouse over each icon to view a pop-up tooltip. 
Below the following graphic are brief descriptions of each item. Detailed 
procedures are covered in the Working with Components in a Tool Library 
(page 35).

 Holder - Puts focus on the Holders document, and opens the Holder 
Wizard where you can create a new holder and add it to the library 
database.

 Assembly - Puts focus on the Assemblies document, and opens the 
Assembly Tree where you can create a new assembly.

 Material - Puts focus on the Materials document, adds a blank row, and 
allows you to create a new material by defining its properties in the 
Properties Grid.
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SEARCHING FOR A LIBRARY COMPONENT   31
 Cut Parameter - Puts focus on the Cut Parameters document, adds a 
blank row, and allows you to create a new cut parameter by defining its 
properties in the Properties Grid.

 New Milling - Puts focus on the Tools document and opens the Tool 
Wizard where you can create a new milling tool.

 New Hole Making - Puts focus on the Tools document and opens the 
Tool Wizard where you can create a new hole-making tool.

TIP: Single-click an item in a document to edit its parameters in the 
Properties Grid. Alternatively, double-click any tool or holder to open the 
Tool Wizard or Holder Wizard where you can edit parameters. You can 
also edit assemblies in the Assembly Tree. Edits you make in the 
Assembly Tree update the parameters in the Properties Grid.

Exercise 3: Searching for a Library Component
In this exercise, you search for a tool library component using the Search window.

1 In the Home tab, click the Search 
button. This opens the Search 
window.

NOTE:  If you do not already have a database (TOOLDB) open, this 
button takes you to an Open dialog box, where you can navigate to and 
open a database. If you cancel the Open dialog box, the Search window 
still opens, and you can access a database from the Open button.

2 Select the Tools button in the 
Search window Home tab. You can 
select any button to search for a 
particular type of database item, but 
for this exercise you search for tools.

3 Select items from the Search Item and Condition drop-down lists, and enter 
appropriate search criteria in the Value field to further narrow (filter) your 
search. For this procedure, enter values as shown below.
TOOL MANAGER GETTING STARTED GUIDE
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NOTES: 

 As soon as you choose a Search Item, a new row in the datagrid 
appears, allowing you to search by more than one Search Item.

 To remove a line of search criteria, select it and press the [Delete] key 
on your keyboard.

 To execute the search through shortcut keys, press [Ctrl] + 
[Enter] on your keyboard.

4 When you finish entering search 
criteria, click the Search button to 
display your search results. Your 
search results should be similar to 
those shown below. 

These results are automatically added to your Recent Search list, accessed by 
clicking the Recent button.
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NOTE: If you do not enter any search criteria before executing a search, 
the search results display all items matching the type of search you are 
conducting. For example, searching for tools without entering search 
criteria results in a list of all tools in the current database.

5 Save the search as a favorite for future reference as follows:
a Click the Favorite button in the 

toolbar.

b Enter FlutesMetricDiameter for 
the name of the search, and click 
Add. 

c The name of the saved Favorite is 
listed in the Favorites folder, 
where you can double-click it to 
recall those specific search 
results.

6 To add an item to a database already open in Tool Manager, drag the item 
from your Search Window and drop it into Tool Manager's Database Explorer. 
The item is added to the appropriate document. For example, if you drag and 
drop a tool into the Database Explorer, Tool Manager will always add it to the 
Tools document, even if you try to drop it into the Assemblies document.
TOOL MANAGER GETTING STARTED GUIDE
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TIP: Use the Default Searches folder in the Search Window to open 
common database searches installed with Mastercam. Double-click a 
search to open it.

7 Click the X in the Search window upper right corner to close the window.
TOOL MANAGER GETTING STARTED GUIDE
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4Working with Components in a Tool 
Library

In this lesson, you learn how to create and edit tool library components.

Lesson Goals
 Create and edit tools, holders, and assemblies
 Use the graphics window display to edit assemblies
 Add and edit materials and cut parameters

Exercise 1: Creating New Tools and Holders
For this exercise, you create a bull-nosed end mill, but the procedure is similar for any 
milling or drilling tool type. For a different tool type, select it from the New Milling or 
New Hole Making gallery buttons. To expand the display of all tool type choices, use 
the controls shown below.

Creating New Tools
1 If necessary, click the Open button 

and open the 
gsg_Tool_Manager_Tut.tooldb 

file.
2 Click the Bull-Nosed Endmill tool 

type in the New Milling group. This 
opens the Tool Wizard.
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3 In the Tool Wizard Define Tool Geometry page, change the following 
parameters:
 Enter 85 in the Overall length field.
 Enter 30 in the Cutting length field.

4 Make sure your parameters in the Define Tool Geometry page match those 
shown in the graphic below. The tool image updates as you make changes.

5 Click Next to work in the Finalize Properties page.
6 In the Finalize Properties page, make the following changes:
 Enter 1 in the Tool number field.
 Enter 21 in the Length offset field and 41 in the Diameter offset field.

7 Make sure your edits in the Finalize Properties page match those shown in the 
graphic below.
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NOTES:  

 The Speeds and Feeds Calculator 
is only available when the Tool 
Manager is accessed through 
Mastercam. It is unavailable in the 
Stand-alone version. These calcu-
lations require an active machine 
group with a workpiece material 
defined.

 To view or edit other options (Coolant button, Cutting Speed, 
FPT, etc.), click the Show More Options bar, and use the vertical 
scrolling bar.

8 Click Finish to save your changes. This adds the new tool to the open library 
(database), and closes the Tool Wizard.
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Creating New Holders
For this exercise, you create a new tool holder.

1 Click the Holder button in the New 
Component group of the Home tab. 
This opens the Holder Wizard.

2 In the Holder Wizard Define Holder Geometry page, change the following 
parameters:
 For the Upper, Type drop-down field, select CAT.
 For the Upper, Size field, type 30 and press [Enter]. This displays and 

highlights the holder that matches your entered parameters.
3 Make sure your parameters in the Define Holder Geometry page match those 

shown in the graphic below.
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NOTE:  If you need to add and define a new segment, click the Add 
Segment button and define the segment parameters in the database 
grid. If you add a segment and then decide that you do not need it, click 
the leftmost cell for that row and press the [Delete] key.

4 Click Next to work in the Finalize Properties page.
5 In the Finalize Properties page, enter GSG Main Holder in the Description 

field and click the Thru coolant checkbox to set the coolant option to flow 
through the holder. 

6 Make sure your edits in the Finalize Properties page match those shown in the 
graphic below.

7 Click Finish to save your changes. This adds the new holder to the open 
library (database), and closes the Holder Wizard.
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Exercise 2: Editing Existing Tools
In this exercise, you edit a tool by accessing the Tool Wizard through the stand-alone 
Tool Manager. Editing a holder is similar so it is not covered. The only difference is, 
when you edit holders, you work in the Holder Wizard as described in the previous 
exercise.

NOTE:  In addition to editing tools and holders through wizards, you 
can select the component in the document, and edit its properties in the 
Properties Grid.

1 Open the Tools document and double-click tool number 463 (3. FLAT 
ENDMILL). This opens the tool in the Tool Wizard.

2 In the Tool Wizard Define Tool Geometry page, change the following 
parameters:
 Enter 5 in the Cutting diameter field.
 Enter 50 in the Overall length field.
 Enter 25 in the Cutting length field.
 Enter 30 in the Shoulder length field.
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NOTE: If you see a message in the graphics display similar to the one 
shown below, ignore it for this exercise. As you complete entering the 
values, the error messages are replaced with the tool graphic because 
you have resolved all geometric property conflicts.

3 Make sure your parameters in the Define Tool Geometry page match those 
shown in the following graphic.

4 Click Next to work in the Finalize Properties page.
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5 In the Finalize Properties page, make the following changes:
 Enter 2 in the Tool number field.
 Enter 22 in the Length offset field and 42 in the Diameter offset field.
 Enter FLAT ENDMILL - GSG in the Name field.

6 Make sure your edits in the Finalize Properties page match those shown in the 
following graphic.

7 Click Finish to save your changes. This adds the edited tool to the open 
library (database), and closes the Tool Wizard.

Exercise 3: Creating and Editing Assemblies
In this exercise, you create a new assembly and edit it by removing and adding 
assembly components.

Creating Assemblies
Create assemblies using a drag and drop method, as described in the following proce-
dure. Although here you only add one holder to the assembly, you can add multiple 
holders as segments of a single holder using the same drag and drop method.

1 Click the Assembly button in the 
New Component group of the 
Home tab. This opens the Assembly 
Tree pod and the Assemblies 
document.

2 Drag and drop a CAT-40 (name C4E4-1000) holder from the Holders 
document into the Assembly Tree.
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3 Drag and drop tool number 448 (23. CBORE) from the Tools document into 
the assembly.

NOTE:  View a graphical representation of your assembly in the 
graphics window by clicking the top line of the assembly.
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Deleting and Adding Assembly Components
Replace an assembly component by deleting it and adding a different component. The 
following process shows how to change a tool in an assembly. This same process 
applies to any component type in assemblies.
To change the tool in the assembly:

1 Click the 23. CBORE tool in the assembly and press the [Delete] key.
2 Drag and drop the 12.6 CBORE tool (tool number 396) from the Tools 

document onto the holder in the Assembly Tree.
Delete that tool from the assembly and add the 23. CBORE tool (tool number 448) 
back into the assembly.

NOTE:  As you add and remove assembly components, the name of the 
assembly changes.
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Editing Assemblies in the Properties Grid
Edit general assembly properties or assembly components by editing the properties in 
the Properties Grid. Follow these steps to edit the 23. CBORE C4E4-1000 assembly you 
created in the previous exercise.

1 Click the 23. CBORE tool in the 
assembly.

2 In the Properties Grid, make the 
following changes:
 Enter New Assembly Tool in the 

Description field.
 In the Manufacturer Name field, 

choose Mastercam from the 
drop-down list.

 Select the Variable Pitch 
checkbox.

 In the Crib Location field, enter 
E-2044.

3 Make sure your changes match the 
graphic shown.

NOTES: 

 Use ellipses buttons for the Edit 
Geometry and Coolant fields to 
access the Tool Wizard and 
Coolant dialog box to edit those 
properties.

 Use editable fields to change properties and parameters for the 
item you have selected.

Make changes to holders and assemblies in the Assembly Tree by editing properties in 
the Properties Grid. Changes are automatically saved to the database as you work.
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For detailed information on using the Assembly Tree and the Properties Grid, click the 
Help button in Tool Manager.

Editing Assemblies in the Graphics Window
Besides editing assemblies by changing settings in the Properties Grid, you can reposi-
tion the assembly (or its extensions) along the center line of the tool in the graphics 
window.

1 In the Assembly document datagrid, select the assembly you worked on in the 
previous procedure (23. CBORE C4E4-1000).

2 In the graphics window, place your cursor over the holder, hold down the 
[Ctrl] key, and click the holder. The assembly is highlighted and a dynamic 
ruler displays.

NOTES:

 The ruler always displays absolute dimensions, which means that the tool 
projection value is always measured from the tool tip to the face of the 
holder.

When you hover over the holder, press the [Ctrl] key to have the 
cursor indicate this mode. If the cursor does not change, you may 
need to click the holder to put focus in the graphics window.

3 Once the ruler displays, move your mouse back and forth along the center 
line of the tool to change the length that the tool extends from the holder. 
You will see the dynamic ruler floating, and the tool projection value in the 
text box changes with your mouse movement.

4 Click anywhere off the tool or holder in the graphics window to set the 
projection distance of the tool.
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TIPS:   

When working with assemblies, you can change the Tool Projection 
value in the graphics window. The Tool Projection field in the Proper-
ties Grid updates as you manipulate the assembly graphic. You can 
also use the Tool Projection field in the Properties Grid to change 
those values.

When the dynamic ruler is active, change the ruler increments by 
zooming in or out with your mouse wheel. This is helpful if you want 
to be more or less precise in your Tool Projection value. The number 
of graduations are appropriate to the selected units specified in the 
Options dialog box.

With the ruler active, click and drag it to snap your Tool Projec-
tion value to the ruler's incremental distance lines. The move-
ment is only between the shoulder length and overall length 
values.

Exercise 4: Adding or Editing Materials and Cut Parameters

Adding or Editing Materials
Workpiece materials are part of Mastercam Tool Manager's TOOLDB database files. 
They display in the Materials document in Tool Manager. Although you can edit some 
of the materials' properties in the Properties Grid, the Materials document is primarily 
used for reference information when working with cut parameters. 

NOTE: Since it isn't possible for a tool manufacturer to test every 
possible material for every tool, the workpiece materials specified in a 
tool library may not match the actual material for a given job. Use the 
ISO group property to find a suitable cut parameter setting as a starting 
point.

1 If necessary, open the Tool Manager from the Start menu and load the 
TOOLDB you have been working with.
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2 Click the Material button. This 
opens the Materials document, and 
adds a new row to the datagrid.

3 Select the first row in the Materials document and set the material parameters 
in the Properties Grid as described below:
 In the Name field, enter 

Aluminum.
 In the Hardness field, enter 60.
 In the Hardness Units drop-

down, choose Rockwell B 
Hardness.

 In the ISO Group Value drop-
down, choose N-Aluminum, 
Copper, and Non-Metallic.

4 To edit the materials properties for that same material, change the following 
values in the Properties Grid as described below:
 In the Name field, enter 

Aluminum - 6061.
 In the Hardness field, enter 95.
 In the Hardness Units drop-

down, choose Brinell Hardness 
Scale.

NOTE: Remember that as you work in Tool Manager, including the Prop-
erties Grid, your changes are automatically saved to the database.
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Adding or Editing Cut Parameters
Cut parameters are part of Mastercam Tool Manager's TOOLDB database files. They 
display in the Cut Parameters document in Tool Manager, where you can edit them as 
needed. These parameters are primarily used in Mastercam when you import cutting 
speed and feed per tooth data into an operation.

1 Click the Cut Parameter button. 
This opens the Cut Parameters 
document, and adds a new row to 
the datagrid.

2 Select the first row in the Cut Parameters document and set the material 
parameters in the Properties Grid as described below:
 In the Material Name field, 

select Aluminum - 6061.
 Make sure the Metric checkbox 

is checked.
 In the Name field, enter 

Shouldering Aluminum with 
16mm Endmill.

 In the Operation Type field, 
select Shouldering.

 In the Feed Per Tooth field, 
enter 0.075.

 In the Axial Depth of Cut fields 
(both Finish and Rough), enter 
10.

 In the Radial Depth of Cut fields 
(both Finish and Rough), enter 8.

 In the Surface Speed field, enter 
90.

 In the Maximum Diameter field, 
enter 18.

 In the Minimum Diameter field, 
enter 16.

Make sure your values match those 
shown in the graphic.
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NOTES:

 Some of the fields are automatically populated and non-editable 
because that information comes from the Material you choose.

 If you are creating a new database or if the desired workpiece material 
does not exist, you need to create the material before creating the cut 
parameters.

 Although you do not edit these values again for this guide, you 
can edit the cut parameters in the Properties Grid as you did for 
the materials in the Adding or Editing Materials section.

3 Leave the stand-alone Tool Manager open.

Exercise 5: Accessing Cut Parameters from Mastercam
In this exercise, you apply the cut parameters you created to a Mastercam toolpath to 
update the surface speed and feed per tooth values.

1 Start Mastercam.
2 Open the part file Dynamic_Mill_Rest.mcam, provided with this guide.

3 Choose File, Save As, and save the part under a different file name. This 
protects the original part file from being overwritten.
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4 Click the Parameters icon for the second operation in the Toolpaths 
Manager.

5 In the Tool page, right-click and choose Search for cut parameters. 

This opens the Search window.
6 Click the File tab in the Search window and open the 

gsg_Tool_Manager_Tut.tooldb file containing the cut parameters you 
created.
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7 Make sure the search criteria is set as shown below, and click the Search 
button.

Your search results will display the cut parameters you created in the previous 
exercise.

8 Select the resulting cut parameters and click the Accept button.

This closes the Search window, and populates the Tool page feed per tooth 
(FPT) and cutting speed (CS) values with the parameter values you accepted.

9 Click OK in the operations dialog, regenerate the toolpath, save the part file, 
and close Mastercam.
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Exercise 6: Copying Components Between Tool Libraries
Use drag and drop to copy items from one database to another. To do this, you must 
have two or more sessions of Tool Manager open concurrently.

1 Start another session of Tool Manager through the Windows’ Start menu.

NOTE: You should still have the gsg_Tool_Manager_Tut.tooldb open in 
the current session of Tool Manager.

2 Click the Open button and navigate to this guide’s install location.
3 Select the gsg_Tool_Manager.tooldb file and click Open to load the 

database. 
4 Position the two sessions of Tool Manager side-by-side or one partly covering 

the other, resizing the windows as necessary.
5 Open the Tools document in each Tool Manager window.
6 In the gsg_Tool_Manager_Tut.tooldb session of Tool Manager, select tool 

number 1 (12 Bull-Nosed Endmill).
7 Drag and drop the 12 Bull-Nosed Endmill onto Cutting Tools in the 

gsg_Tool_Manager.tooldb session of Tool Manager. Because the copied 
tool has the same tool number as an existing tool, it is renumbered to the 
next available number. 
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NOTES:

 You can copy database items under the following drag and drop condi-
tions:
 From one database Assemblies, Holders, Tools, Materials, or Cut 

Parameters document to another database's document of the same 
type.

 From any Assemblies, Holders, or Tools document in one database to 
the Assembly Tree of another to build or copy new assemblies.

 You can change tool numbers by double-clicking the tool in the 
document and changing the tool number in the Tool Wizard, or 
you can highlight the tool in the document and change the tool 
number in the Properties grid.

8 Close both sessions of the stand-alone Tool Manager.
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LESSON 5
5Using Tools and Holders in Toolpaths

In this lesson, you learn to work in Mastercam’s classic Mill Tool Manager using the 
stand-alone Tool Manager’s integrated functions.

Lesson Goal
 Create and edit tools and holders using classic Tool Manager

Exercise 1: Creating New Tools and Holders
In this exercise, you create a new tool and holder from within Mastercam. These 
tooling components are applied to a dynamic mill toolpath on the part supplied with 
this guide.

Creating a New Tool
1 Start Mastercam.
2 Open the part file Dynamic_Mill_Rest.mcam, provided with this guide.

3 Choose File, Save As, and save the part under a different file name. This 
protects the original part file from being overwritten.
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4 Click the Parameters icon for the first operation in the Toolpaths Manager.

5 In the Tool page of the Dynamic Mill dialog box, right-click in the tool list and 
choose Create new tool. This opens the Tool Wizard.

6 In the Select Tool Type page, select End Mill, and click Next.
7 In the Define Tool Geometry page set the following tool parameters:
 Enter 18 in the Cutting diameter field.
 Enter 90 in the Overall length field.
 Enter 60 in the Cutting length field.
 Make sure the Shoulder length field has a value of 60.
 Make sure the Shoulder diameter field has a value of 18.
 Make sure the Shank diameter field has a value of 18.

8 Make sure your parameters in the Define Tool Geometry page match those 
shown in the following graphic.
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9 Click Next to work in the Finalize Properties page.
10 In the Finalize Properties page, make the following changes:

 Enter 18 Flat Endmill - GSG in the Name field.
 Enter New Tool for GSG in the Description field.

11 Make sure your parameters in the Finalize Properties page match those 
shown in the graphic below.

12 Click Finish to save your changes. This adds the new tool to the part, closes 
the Tool Wizard, and returns you to the Tool page.
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13 In the Holder page of the Dynamic 
Mill dialog box, choose the Open 
library button, navigate to your 
gsg_Tool_Manager_Tut.tooldb, 
and open that library.

NOTE: Text in the window indicates 
the current library.

14 Choose the New holder button. This 
opens the Holder Wizard.

15 In the Define Holder Geometry page, set the following tool parameters:
 Choose CAT from the Upper connection Type drop-down field.
 Enter 30 in the Upper connection Size field and press [Enter].
 Enter 18 in the Lower connection Size field.

16 Make sure your parameters in the Define Holder Geometry page match those 
shown in the graphic below.

17 Click Next to work in the Finalize Properties page.
18 In the Finalize Properties page, make the following changes:

 Enter New Holder for GSG in the Description field.
 Check the Thru coolant checkbox to set the coolant to flow through the 

holder. 
19 Make sure your parameters in the Finalize Properties page match those 

shown in the following graphic.
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20 Click Finish to save your changes. This adds the new holder to the part, closes 
the Holder Wizard, and returns you to the Holder page.

NOTE: You can see the new holder is added to the list, but not yet saved 
to the library. This is indicated with a message in the window and an 
asterisk next to the new holder name.
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21 Click the Save library button to 
open a dialog box, navigate to the 
.TOOLDB location, and save the new 
holder to your library.

22 Click OK in the Dynamic Mill dialog box. This marks the toolpath dirty.
23 Click the Regenerate all selected 

operations button to update the 
toolpath.

Exercise 2: Editing Tools and Holders
In this exercise, you edit a tool and holder.

1 Click the Parameters icon for the second operation in the Toolpaths 
Manager, and go to the Tool page.

2 Right-click tool #476 and choose Edit tool. This opens the Tool Wizard.
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3 In the Define Tool Geometry page, change the Shank diameter to 22.
4 Click Finish to save your changes. This closes the Tool Wizard, and returns 

you to the Tool page.
5 Click OK in the Pocket dialog box, and regenerate the operation.
6 Click the Parameters icon for the first operation in the Toolpaths Manager.

7 Go to the Holder page, right-click the CAT 30 - ID 18 holder and choose Edit 
Holder. This opens the Holder Wizard. Your list may not look exactly like the 
graphic shown.

8 In the Define Holder Geometry page, click Next to leave settings as is.
9 In the Finalize Properties page, change the Name to CAT 30 - ID 18 - GSG.

10 Click Finish to save your changes. This adds the edited holder to the part, 
closes the Holder Wizard, and returns you to the Holder page.

11 Save your changes to the library as described in the previous exercise.
12 Click OK in the Dynamic Mill dialog box.
13 Save the part file.
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Conclusion
Congratulations! You have completed the Tool Manager Getting Started Guide tuto-
rial. Now that you have mastered the skills in this tutorial, explore Mastercam’s other 
features and functions. 
You may be interested in other tutorials that we offer. The Mastercam tutorial series is 
in continual development, and we will add modules as we complete them. 

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

 Mastercam Help— Also, most dialog boxes, function panels, and ribbon bars 
feature a Help button that opens Mastercam Help directly to related 
information. 

 Mastercam Reseller—Your local Mastercam Reseller can help with most 
questions about Mastercam.

 Technical Support—CNC Software’s Technical Support department (860-875-
5006 or support@mastercam.com) is open Monday through Friday from 8:00 
a.m. to 5:30 p.m. USA Eastern Standard Time.

 Mastercam Tutorials—CNC offers a series of tutorials to help registered users 
become familiar with basic Mastercam features and functions. The Mastercam 
tutorial series is in continual development, with new modules added as we 
complete them. 

 Mastercam University—CNC Software sponsors Mastercam University, an 
affordable online learning platform that gives you 24/7 access to Mastercam 
training materials. Take advantage of more than 180 videos to master your 
skills at your own pace and help prepare yourself for Mastercam Certification. 
For more information on Mastercam University, please contact your 
Authorized Mastercam Reseller, visit www.mastercamu.com, or email 
training@mastercam.com. 

 Online communities— You can find a wealth of information, including many 
videos, at www.mastercam.com. For tech tips and the latest Mastercam news, 
follow us on Facebook (www.facebook.com/mastercam), Twitter 
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). 
Visit our YouTube channel to see Mastercam in action (www.youtube.com/
user/MastercamCadCam)!  
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Registered users can search for information or ask questions on the 
Mastercam Web forum, forum.mastercam.com, or use the knowledge base at 
kb.mastercam.com. 

Mastercam Documentation
Mastercam installs the following documents in the \Documentation folder of your 
Mastercam installation:

 What’s New in Mastercam 2017
 Mastercam 2017 Installation Guide
 Mastercam 2017 Administrator Guide
 Mastercam 2017 Transition Guide
 Mastercam 2017 Quick Reference Card
 Mastercam 2017 ReadMe

Contact Us
For questions about this or other Mastercam documentation, contact the Technical 
Documentation department by email at techdocs@mastercam.com.
TOOL MANAGER GETTING STARTED GUIDE

http://forum.mastercam.com
http://kb.mastercam.com
http://www.facebook.com/mastercam
http://www.twitter.com/mastercam
http://www.youtube.com/user/MastercamCadCam
http://google.com/+mastercam
http://forum.mastercam.com
http://www.mastercamu.com
mailto:techdocs@mastercam.com
mailto:techdocs@mastercam.com


64  MASTERCAM 2017 / Using Tools and Holders in Toolpaths
TOOL MANAGER GETTING STARTED GUIDE



HOW MASTERCAM RENDERS TOOL PROFILES   65
APPENDIX A
1Rendering Mastercam Tools

Mastercam has the ability to define a tool using parametric properties along with a 
custom profile that can be imported from a CAD file, or a part file created in 
Mastercam. The parametric values are used within the toolpath calculations for 
improved performance. The optional custom profile, when provided, is used for stock 
model generation and collision checking in Backplot, Verify, and Machine Simulation. 
Mastercam’s Tool Wizard provides the option of displaying both profiles for compar-
ison. 
The Tool Wizard renders the custom profile as a 3D shaded tool and overlays the 
parametric profile using a dotted line. You can toggle this behavior to render the para-
metric tool and overlay the custom profile by selecting the desired option from the 
Render Mastercam Tool list. 

How Mastercam Renders Tool Profiles
When you use a tool profile to create a new tool, whether you import the profile from 
an external file (DXF) or from a profile stored in your part file, if you choose to create 
the tool based on the Custom Tool type, Mastercam tries to approximate its parame-
ters. Frequently, Mastercam fails to populate the Custom Tool parameters accurately. 
The tool may look correct in the Tool Wizard when rendered as an imported tool and 
will display as a correctly-defined tool in backplot and verify, but Mastercam uses the 
tool parameters from the Define Tool Geometry page in the Tool Wizard when 
creating toolpaths, which do not always match the true tool profile. This can result in 
unexpected toolpath behavior such as gouging, leaving too much stock, or random 
airlifts. Mastercam is using the toolpath compensation based on the parametric values 
rather than the imported profile shape.
The example below shows an incorrectly defined bull endmill tool from a profile 
stored on level 200 in the Custom_tool_Testing.mcam part file included with this 
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tutorial. You can see that the rendered tool that Mastercam created (shown on the left) 
does not match the actual definition from the imported profile (shown on the right). 

Even though the rendered Imported Tool shown on the right looks correctly defined, 
Mastercam uses the rendered Mastercam Tool shown on the left during toolpathing. 
The results of the cut are shown below, viewed from the right-side view. Because 
Mastercam is compensating the toolpath to the Mastercam Tool, which is shaped like 
a flat endmill and not the Imported Tool, the tool is not cutting to the surface of the 
part, but rather leaving a gap. Mastercam is compensating the toolpath to the theoret-
ical corner of the Mastercam Tool, even though it displays as the Imported Tool. 

This can often be misdiagnosed as a toolpath problem. If you have a referenced 
profile and/or custom tool and are seeing something incorrect in the toolpath, check 
your tool definition and make sure that the Mastercam Tool and Imported Tool match.
TOOL MANAGER GETTING STARTED GUIDE



CREATING NEW TOOLS FROM PROFILES   67
View this by backplotting operations 1 and 2 of the Custom_tool_Testing.mcam part 
file included with this tutorial.
To create custom tools based on profile geometry, it is almost always best to select a 
tool type that most closely resembles the tool you are creating rather than basing the 
tool on the Custom Tool type. By basing your custom tool on a similar tool type, you 
can parametrically define the tool to match the Mastercam Tool upon which your tool-
paths are calculated.

Exercise 1: Creating New Tools from Profiles
In this exercise, you create a new tool based on a tool profile from within Mastercam. 
These tools are used in toolpaths on the part supplied with this guide.

NOTE: This part is in English, based on the default inch Mill machine 
definition.

Creating a New Tool from a Profile
1 Start Mastercam.
2 Open the part file Custom_tool_Testing.mcam, provided with this guide.
3 Right-click in the graphics window and choose Fit to fit the part to the screen. 

Your part should look similar to the graphic below.
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4 Choose File, Save As, and save the part as 
Custom_tool_Testing_Tut.mcam. This protects the original part file from 
being overwritten.

5 Choose Toolpaths, Tool Manager.
This will open the Tool Manager 
where you will be creating a custom 
tool similar to the 0.375 Bull-Nosed 
Endmill tool used in operation 4.

6 In the Tool Manager, right-click in the Tool list window (upper window) and 
choose Create new tool. This opens the Tool Wizard.

7 Choose the Bull Mill tool type 
because the custom tool profile is 
created as a bull-nosed endmill.

8 Click Next to advance to the Define Tool Geometry page.
9 Click Import and link to custom 

geometry from a level.
This opens the Select Level dialog 
box.

10 Select Bull mill shoulder on level 
200 and click OK.
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11 Toggle between viewing the custom tool as a rendered Mastercam Tool or a 
rendered Imported Tool. They do not match. The Mastercam Tool parameters 
need to match the Imported Tool profile. 

12 On the Define Tool Geometry page, enter the following parameters:
 Enter 0.375 in the Cutting diameter field.
 Enter 2.5 in the Overall length field.
 Make sure the Cutting length field has a value of 0.83333.
 Enter 0.125 in the Radius field.
 Enter 1 in the Shoulder length field.
 Enter 0.375 in the Shoulder diameter field.
 Enter 0.5 in the Shank diameter field.
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13 Make sure your parameters in the Define Tool Geometry page match those 
shown in the following graphic.

NOTES: When creating custom tools from imported profiles, 
Mastercam populates the parametric fields with estimated values. 
However, you must edit these values to match the imported profile 
parameters. Usually these imported tool profile parameters are retrieved 
in one of the following methods:

 If the tool profile was created without importing it from a clearly-
defined specification, you can analyze the profile geometry in 
Mastercam to obtain the values.

 If the tool profile was imported from a manufacturer, you can find the 
values from their web site or tooling catalog.

 If you have a tool but do not know the origin of that tool, you 
can obtain the parameters using a tool setter to measure the 
tool values.
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14 Toggle between viewing the custom tool as a rendered Mastercam Tool or a 
rendered Imported Tool. You can see that the rendered shapes match, 
showing that the Mastercam Tool that is used to create the toolpath has the 
same profile values as the Imported Tool. 

15 Click Next and edit the parameters as shown below on the Finalize 
miscellaneous properties page, renumbering the tool as needed.

16  Click Finish when done.
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17 If you have numbered the new tool with a number already assigned to a tool 
in the current library, a similar tool warning will appear (as shown below).

18 Click OK to add the similar tool. Tool libraries allow multiple tools with the 
same number.

19 Click OK in the Tool Manager to accept your changes.
20 To view a similar, correctly-defined tool, backplot the fourth operation in the 

Custom_tool_Testing_Tut.mcam. file, rotating the part to view the corrected 
toolpaths. The tools now cut accurately and you can see that the new 
parametric tool definition matches the tool profile used in Backplot, tracing 
the surface as expected.
TOOL MANAGER GETTING STARTED GUIDE
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